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Introduction
Dinesh is a university student and also a part time job holder. His part time job requires him to use excel templates, data validation and lots of other things relating to advanced excel which he is not very good at. Most of the times he has to spend a few hours to do something in excel which an excel expert could have done in few minutes. His cousin Sashikola works in a multinational company as an excel expert. Today Dinesh came over to Sashikola’s place with a view to getting some tips from Sashikola on advanced excel. Since its Sunday, Shashikola is free too. After they had some preliminary conversation Dinesh started to attack Shahikola with all his advanced excel related questions. First one was about the template. 
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Objectives: 

After you will finish reading this chapter, you will be able to:
· Create a default workbook and worksheet templates

· Generate more consistent spreadsheet quickly 

· Recognize the importance of customizing an excel interface

· Know how to make spreadsheets more efficient and less risky

· Know the key techniques that can help in reduction of risk 

· Use the documentation and review tools 

· Work with validation formulae

· Create lists and lists that depend on other list selections

· Track down invalid entries

Template

“Could you explain everything from the scratch about Excel?”, asked Dinesh to Sashikola eagerly. “Yes! I would do that. Let me begin by explaining how powerful this tool is”, said Sashikola. 
“Microsoft Excel is a very powerful tool that lets the users manage and analyze large amount of data efficiently and quickly. This tool is fairly easy to learn. Let me explain what a worksheet and workbook refer to ”, explained Shashikola.
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“A worksheet is a single spreadsheet that consists of cells that are organized in the form of rows and columns. Each cell can contain text, formula or a number. A workbook on the other hand, refers to a file which consists of one or more worksheets. These are present in separate tabs indicated at the bottom of the window. Three worksheets are present by default in an excel workbook”, said Shashi to Dinesh who looked interested with the new piece of information being taught.  
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“How would you define a template, then”, questioned back Dinesh almost instantaneously. 
 “A template refers to a collection of formats and styles that can be applied to an entire worksheet. This saves a considerable amount of time of the user as it is quite easy to apply any template to the worksheet that is already being worked on. Many templates are built in within the program which can be used anytime by the user and are absolutely free”, explained Sashikola to enthusiastic Dinesh who seemed immersed in the conversation about Excel. 
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“How do I create a default workbook and worksheet template”, asked Dinesh.  
Sashikola immediately answered this question,“If a user creates their own template, then they can store them safely in a folder referred to as Templates folder. On the basis of this template, new workbooks can be created without having to worry about overwriting issues”.  
A template can be created in the following manner: 

1. Create a workbook

2. Click Save As on the green File tab

3. Enter a name for the file

4. From the drop-down list, select Excel Template (*.xltx)
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Automatic activation of templates folder is done by Excel. It is vital to observe the Template folder location on the device. The default location is:

            C:\Users\<username>\AppData\Roaming\Microsoft\Templates
5. Click Save.
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For creation of a workbook based on the template, the following steps need to be executed: 

6. Click New on the green File tab.
7. Click My Templates icon.
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8. Select WeddingBudget.

9. Click OK.
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Based on this template, Excel creates a working by name WeddingBudget1.xlsx. 
· Modular Templates

“There is another term called Modular template in Excel which makes a spreadsheet more consistent and much quicker to set up. Modular Spread Sheet Development makes it quite easier for building spreadsheets quicker exponentially. This as well reduces the risk of errors associated and makes it quite easier to understand the spreadsheets. This concept of modular templates is entirely new”, further added Sashikola. 
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“Could you provide me with an example where you have developed modular templates?”, asked Dinesh swiftly. 
“The first model I built was for an energy company. I almost took three months to complete it. The second one was for a water company and this was entirely different from the previous company, however, the logic that needed to be applied was the same. So, instead of beginning all over again, I deleted few parts from the previous model which weren’t applicable to the water company. In this manner, I completed half of the model within a day. With this, I developed an obsession for efficiency. It is quite insane to spend days and nights on something that can be solved quickly with application of pure logic. The best thing about Modular Spreadsheet Development is that it aids in the creation of infinite opportunities to enhance the way the spreadsheets are developed, used, and shared”, explained Shashikola enthusiastically.  
· Customize excel interface
“I have come across the term excel interface customization quite often. Could you explain me what it is and how is it helpful?”, fired back Dinesh almost speedily after the reply from Sashikola.  
“Whoever thinks that excel is boring isn’t aware of the settings offered to animate the workbooks. For instance, one can let a column slide into the desired position with the use of animations. This can make the entire process of working with excel interesting and fun”, came a speedy reply from Sashikola. 
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Follow these steps if you wish to turn on the feedback animation on your device:  

1. Click on the Tools menu and Choose Options. An Options dialog box opens immediately. 
2. Then click on the Edit tab. 
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The Edit tab of the Options dialog box.

3. Ensure that you Provide Feedback with Animation with the check box selected.

4. Click on OK.
You can turn off the animations if you do not prefer to waste CPU cycles over  frivolous animations. 
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Efficiency and risks
“Are you aware that spreadsheets can me made more efficient and less risky”, asked Sashikola to eager Dinesh who seemed lost absorbing every piece of information delivered to him. 
“No, Enlighten me”, replied Dinesh. 

Sashikola explained, “Excel is a very dominant spreadsheet application. The users can design their own spreadsheets. Many spreadsheets possess a poor foundation and also have their life spans limited. To maximize the efficiency, the best thing to do is to remember that there isn’t any need to add more formulae or data to the spreadsheet. A spreadsheet should always be developed with 80% planning and then 20% implementation. Spreadsheets are ideal for use in financial and accounting tasks. Efficiency experts would suggest you to make use of a tool that is specifically dedicated for accounting tasks. This would make the entire process much more efficient. However, many users aren’t aware that there are risks involved in such processes. Spreadsheet problems severely impact finance, economics and accounting modeling.”
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Build in check and controls from the outset
“I would like to explain you a concept of build-in check and controls from the outset. I would explain this concept with an example. I was asked to present a lecture on Excel a while ago and one of the attendees contacted me to help him out with a spreadsheet that he was developing ,” said Sashikola to Dinesh who appeared slightly confused. 
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“The spreadsheet was a financial spreadsheet and was quite complicated. An overall report set was developed by consolidating results from various sources. He decided to include a balance sheet soon after finishing the spreadsheet. The balance sheet wasn’t balanced and he wanted to know the way by which he could track the problem. After tracing the formulae, I found out that there existed several issues. I advised him to start all over again. The overall development time could have been significantly reduced by 50%-80% had they included the balance sheet in the beginning. Key checks can less likely be omitted by planning checks while designing. Referring and incorporating checks during the spreadsheet development stage can significantly help. Checks don’t have to be exact, but having alerts build in can help in minimizing errors”, narrated Sashikola.      
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· Key techniques that reduce risk and increase efficiency and automation 
Dinesh again shot a question at Sashikola, “Microsoft Excel is almost used for everything from analysis and financial reporting to budgeting and forecasting. How can I know that my spreadsheets are accurate and aren’t at risk? How would I know that there are errors in my spreadsheet?”
Sashikola replied, “There are several techniques that can be implemented in the right manner to reduce the risks and increase efficiency and automation. The first and foremost thing to do is to reduce the impact and volume of errors in a spreadsheet. Prevention of errors is a great way to minimize the risks.”
The following techniques can be followed: 
1. Reduce the number of spreadsheets 

This may seem a very simple technique. With the reduction in the number of spreadsheets, the errors are also minimized. For this purpose, it is better to realize that it is vital to study the purpose for which a spreadsheet is being employed. For instance, many organizations make use of spreadsheets for forecasting and budgeting applications. These can be automated and preference must be given to the construction of a worksheet. Working in a hurry without applying logic while constructing a spreadsheet will give rise to more errors.     
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2. Formulas shouldn’t be embedded based on assumptions
Formulas shouldn’t be directly embedded based on only assumptions. Assumptions should be placed in external cells. These can then be referred while deriving formulas.   
3. Worksheet and workbook protection should be applied for prevention of changes by unauthorized people

Numerous options are offered by Excel for securing the spreadsheets so that no changes are made into the carefully constructed spreadsheets by unauthorized users. The user can enable workbook protection, worksheet protection and simple password protection in order to ensure the accuracy of the content.   
4. Use tables as sources of data

Numerous advantages are offered to the users while working with tables. Quick and persistent formatting can be done with the use of tables. Conversion of data ranges is possible and calculations can also be done easily.

5. Use pivot tables for automatic calculations

Pivot tables are one of the most powerful tools offered by Excel. These can perform calculations on various data records. Without the aid of any user formulas, the pivot tables can summarize a large volume of data. This would in turn enhance the accuracy of spreadsheets.     
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6. Use formula editing tools for minimizing errors

Excel offers numerous tools for formula editing. Trace Dependents, Evaluate Formulas and Show Formulas can be used for analyzing the errors in the spreadsheet.   
· Documentation and review tools 

“There is another concept referred to as the Document Review tool provides a lot of options to the users. The member who integrates this tool into a workspace becomes the author of the document. The author is the only member who can see the options pertaining to addition of original documents to the tool by the initiation of document review. The members who are invited to review are given an exclusive copy to add their reviews and edits into the original document. The reviewers can even make use of options to change the review status. Once all the reviewers save their copies, the author can incorporate all the comments into a single file”, further added Sashikola.     

Data Validation
“What is Data Validation? How does one work with validation formulae?” Dinesh questioned again. 

“The data validation feature in Excel helps in controlling the data being entered into the worksheet”, answered Sashikola.  
The user can:

1. Create a drop down list of all the items within a cell

2. Restrict the entries such as the range of date

3. Create custom rules for the entries
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· Lists and lists that depend on other lists

“I have often been asked to create lists and have also heard about dependent lists. Could you please explain to me this concept?”, asked Dinesh swiftly.

“Yes! A drop down list can be created with a list of options. There are options to enter the list directly in the dialog box of Data Validation. Consider this example for instance”, exclaimed Sashikola. 

List creation with manual data entry
1. Type the list title
2. Type the entries right below the heading cell. Do not leave blank cells in between the entries.  
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List creation with table insertion 
1. Select the cell and then click on Table from the Insert tab.  
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2. Create a check mark and then select OK. 
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Name the List Range

A name range can then be created which doesn’t include the heading cell. This range is dynamic and adjusts automatically upon addition of items or when they are deleted.
1. Click on the heading cell to select all the cells within the list. 
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2. On the left of the formula bar, click on the Name box

3. Type a name for the list 
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Apply the Data Validation

Once a name range is created, it can used to create a list in one or more cells. 

1. Choose the cells in which you want to create the drop down list
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2. Click on Data Validation on the data tab. 
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3. Choose List from the Allow drop-down list
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4. Click in the Source box and then type the equal sign followed by the name of the list
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5. Click on OK to close the Data Validation dialog box.

6. Click on one of the cells and then select the drop down arrow
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7. Select the item in the drop down list to enter it into the cell.
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“You can create an Excel table or you can create a named range for later use. The lists can be used from the same sheet or from some other sheet”, explained Sashikola. 

· Tracking down invalid entries
“I have often come across people referring to tracking down invalid entries. Could you explain what this concept is all about?” questioned Dinesh again.  
“Many users face a problem when they try to close a workbook that has thousands of formulas. The message displayed in such cases is: "A formula in this worksheet contains one or more invalid references”. It is hard to figure out which worksheet in the workbook is causing this problem. Tracking down invalid entries can be quite frustrating. One needs to look at several places in order to figure out the problem. The first place to look for error is to check for the formulas on the worksheets. This has to be done on each worksheet till the root of the problem is identified”, explained Sashikola.  
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She further added, “The user can use the Do To Special dialog box and choose only the cells that consist of the errors. The Tab key can also be used amongst the cells selected by Excel. The Find tool can also be used to find out the possible errors. To display the Find tab, then the user can press Ctrl+F. Then the user search for the character “#”. Ensure that the search needs to be done within the formulas within the worksheets. Each and everything needs to be inspected.”     

“The users also need to inspect the named ranges within the workbook that have been defined. The Name Manager dialog box needs to be used to look for each name. Error indications need not be included in the Refers To column. Excel is an expert in highlighting the errors that exist within a file. If a user needs to frequently check for errors, then he or she can try the macro which can look for potential errors within the formulas”, she further explained.      
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Test  your Understanding

1. Suppose, you need to handle huge data and wish to create excel files frequently, which feature of excel would you make use of? 

2.  Suppose, you are working on several projects with excel, how would you increase the efficiency of the process and minimize the risks?

3. Suppose, you are working on a huge project, how would you track down all the invalid entries within a workbook?

4. Suppose, you are working on a project which needs to be reviewed by the project head, which feature would you make use of?

5. Suppose, you need to work with a lot of data using Excel, which feature would you make use of to bring in creativity in the interface?   
6. Suppose, you have been asked to start a project on excel, how would you create a default template?  
Use Of Advanced Excel Techniques In Industry 
· Introduction

· Functions and super powers

· Finding right functions and their works

· Functions with hidden powers

· Making references to a range of cells adapt automatically for new data

· Array formulae

· One formula, one million calculations

· SUMPRODUCT () - all the gain of an array formula with less pain

· Tables

· Tables- structure comes to excel

· Tables and its importance

· Make spreadsheet more automatic with a single command

· Table formulae- instant readability

· Data tools in tables

· Advanced range names

· Use the same name on different sheets

· Using the name manager

· Names in formulae- efficient inclusion of names, the use of intersections

· Formulae in names- how to allocate a formula directly to a range name and why that is needed

· Using excels to help you make decisions

· Use goal seek to know your need.

· Use data table to calculate several possible outcomes

· Create and manage alternative scenarios

· Make more profit by using excel solver to identify the best solution

· Problem solving

· Calculations that make decisions- understanding true and false

· Boolean logic and its usefulness

· Combining logic and arrays to solve complex problems

· Practical examples

· Test your understandings 

Introduction

After facing a lot of questions on the templates, how to make spreadsheets more efficient & data validation, Shasikola made those topics clear to Dinesh. She also explained him about the functions and super powers and table command. But as a novice in advanced excel Dinesh could not understand all the aspects regarding those points. Getting back to his dormitory, Dinesh tried on his own. Day by day he discovered a lot of things that he didn’t know previously and he also found that knowing those things made his work easier in the company where he was working. 

But still, he was not aware of a lot of things. He comes across terms like advances range names, using goal seek to know requirements, etc. So he gets in touch with Shasikola again to get a clear idea of the new terms.  

Shasikola assures him that she would meet him in a few days to explain the terminologies. Shasikola lived up to her word and took Dinesh to her place during the weekend. There she explained Dinesh how advanced names range, goal seeking, Boolean logics are used in various aspects in her company.
Objectives: 

After you will finish reading this chapter, you will be able to:
· Recognize the importance of functions and their works

· Create array formulae and learn how to use them

· Learn the structure of tables and their importance

· Make spreadsheet more automatic with a single command

· Use Advanced range names

· Use name manager, names in formulae

· Use excel in decision making

· Use data table in calculations

· Recognize the importance of Boolean logic and learn its usefulness

· Functions and super powers

“I’m coming across various terms such as Excel functions and super powers these days at work and I absolutely have no idea what they mean. Could you please shed some light on the topics ”, questioned Dinesh as Sashikola patiently absorbed the question throw at her.  
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Sashikola then started explaining, “There are any companies that make use of Excel. It is used for various purposes right from the creation of a simple list to management of a complex portfolio of financial instruments. Its applications in the financial, manufacturing and large multinationals is immense. With the increase in complexities, the users need to make use of functions and super powers to solve complicated problems that need to run for days and weeks in many cases to provide an optimal solution.”

“You mean to say that traditional approaches wouldn’t work while solving complex problems?”, fired back Dinesh. 

“Yes! You got it right. Traditional approaches would only make a user go through pain in order to obtain optimal results. The problems associated with long running workbooks made Microsoft come up with power options for Excel. These services allow parallel and faster calculations thus bringing down reduction in the run times”, explained Sashikola enthusiastically. 
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Finding the right functions and their works

“That was a fabulous piece of information! How would I know which function to use under a specific set of conditions?”, questioned Dinesh. 

Sashikola replied almost instantly,“Microsoft has brilliantly categorized the functions based on their functionality. Functions have as well been updated with over time to provide accuracy in the solutions and reflect their usage in a better manner. The categorization of functions makes it easier to use them. They can be used based on the needs. For instance, Statistical functions can be used to solve any accountancy problem wherever required. This would provide the required solution quickly based on the volume of the data.”
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Functions with hidden powers

“You would be amazed to hear that there are certain functions that have hidden powers”, said Sashikola ardently while explaining the powers of Excel. 

“I wasn’t aware that Excel was an advanced tool. I always skipped Excel classes while in School only to realize years later that it is much more than what I thought it to be”, expressed Dinesh despondently.  

“Excel isn’t merely for people with accounting degrees who love playing with numbers all the day. The functions come with hidden features that make working with spreadsheets much more productive”, added Sashikola.
Tips and tricks for Microsoft Excel

“Are there are any tips and tricks that one can follow while using Excel?”, fired back Dinesh. 

“You shouldn’t even be asking this question. Yes! There are several tips and tricks that Excel users can follow to make their lives easier”, replied Sashikola. 

1. Instant conversion of formulas to obtain results 

Worksheets commonly consist of one or more calculated columns which include converted text, a range of data and so on. The formula can be entirely eliminated and the results can be obtained directly. All the user need to do is to copy the entire range to be converted and then paste it with the aid of a Paste Special function. Keyboard shortcuts can help in streamlining the entire process.       
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2. Automatically highlight the data with conditional formatting.

Excel is commonly used to display a huge volume of data in the numeric form. It isn’t possible to identify the problem by just looking at the data. Conditional formatting can be used in such cases where the cells can be colored. For instance, if there is a worksheet that consists of sales figures under the product category, you can highlight the data in red and the above average figures in green. This will simplify the entire process and make it convenient for studying the figures.  
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3. Copy a worksheet tab with drag and drop feature

There are several reasons why one would want to copy a worksheet tab. If a user wants to copy the budget of the previous month into a new tab, then it can be done easily with this tip. A backup copy of the worksheet tab can also be done with this featuring without tampering the originality if the worksheet tab.  Although, a user can make use of dialog boxes or menus for the purpose, the quickest way to accomplish the task is by following this tip.  
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4. Make use of the AutoSum feature for more than sum calculation 

AutoSum feature has been in use since the earliest days. Many users just use this feature to sum numeric data. Many users barely know that by mere clicking of the AutoSum button on the tab makes Excel insert a SUM function formula in the selected cell. By clicking the drop down arrow to the right, extra features are presented to the users. Average of columns and rows can as well be calculated with this feature. When used in conjunction with tables in Excel, the user can do much more. Clicking on any cell of the table will create a new table with all the calculations. The user will never have to enter the calculations manually.  
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Making references to a range of cells adapt automatically for new data

· Array formulae

“What are Array Formulae? I come across this term often, but I am entirely clueless about what it means”, questioned Dinesh politely. 

Sashikola replied,“If you wish to become a power user, it is vital to be aware of the array formulas. These can be used to perform calculations which cannot be done with non array formulas. Fairly sophisticated operations can be performed with the use of these formulas. For instance, if you wish to calculate the total cost of a loan over a fixed period of time, you can do this in no time provided you know how to make use of array formulas. These are really helpful and you must know how to use these if you wish to a power Excel user. ”
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One formula, one million calculations

“Array formulas are quite powerful when you’re dealing with complex problems. If you have a slight idea about programming, you must be aware of the term array. Array refers to a collection of items. These items can be present in a single column or a row. These can as well be present in multiple rows or columns. An array formula is powerful enough to perform multiple calculations in one or more items within an array. These return either a single result or a multiple result. Based on how your array is, a single formula has potential enough to perform one million calculations”, added Sashikola further explaining about array formulas. 
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SUMPRODUCT () - all the gain of an array formula with less pain

“What is a SUMPRODUCT function? Is it associated with arrays?”, questioned Dinesh. 

“The SUMPRODUCT function works with arrays, but it doesn’t require the user to use the normal array syntax. This function is used to find the product and then sum the arrays. The use of this function seems to be complex and boring. However, many do not know that this is quite a versatile function which offers many uses to the users. Ranges of cells can be processed elegantly with the aid of this function ", explained Sashikola. 
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Tables

“Is there anything else in Excel that is quite significant?”, questioned Dinesh. 

“There are many concepts in Excel that I haven’t covered yet. Many functions keep getting added up every now and then. Have you come across the term “Tables”? You must have! These are vital in Excel! ”, exclaimed Sashikola. 

Tables- structure comes to excel

“Why don’t you explain their role then?” fired back Dinesh almost instantly. 

“Tables are one of the features in Excel of which many users aren’t aware of.  After getting acquainted with Tables, one would wonder why that never stumbled across this feature? They make the life of Excel users a lot easier in several situations. Tables take a few of the niftier aspects of the pivot tables and named ranges and make it convenient to solve various problems much easily”, replied Sashikola. 
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Tables and its importance

“Could you explain to me the importance of tables”, asked Dinesh. 

“Tables can help in analyzing and managing a group of data. Range of cells can easily be converted into a Table”, replied Sashikola. 

Significance of the table features: 

1. Filtering and Sorting

Automatic addition of drop-down lists can be done in the header row of any table which can help in sorting the tables in ascending or descending order or even by color. Sorting can be customized. The data in the tables can be filtered to meet specific criteria.  
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2. Easy formatting of table data

A table can be quickly formatted with the application of custom table style. This can aid in displaying data in a tabular formula which in turn would make it easier to study the data. It even makes it easier to distinguish the data and draw better comparisons.  
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3. Ensure integrity of data

Various built-in features are offered by Excel as far as tables are concerned. For instance, the user may choose to allow only dates or numbers within a  table column.

4. Export SharePoint list

A table can be exported to a SharePoint list so that people can edit, update and view the data of a table. 

· Spreadsheet can be made more automatic with just a single command

· Instant readability is offered by the formulae

· Various uses of data tools

Advanced range names

“Could you explain Advanced range names”, questioned Dinesh. 

Sashikola explained, “Advanced range names can be created easily in Excel which can automatically contract or expand based on the items. ”

Using the name manager
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“A Name Manager dialog box can be used to manage names. This dialog box can be used to work with all tables and defined names within the workbook. For instance, if you find any errors in the names, confirm the reference of a name or value, edit the descriptive commands or determine the scope with the aid of Name Manager dialog box. Sorting and filtering of the list of names can be done by the Name Manager. Names from location can be added, changed or deleted easily”, explained Sashikola. 
The Name Manager dialog box can be opened by clicking on the Formulas tab which is present in the Defined Names group.   
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Names in formulae- efficient inclusion of names, the use of intersections
“What is the purpose of using names in formulae”, questioned Dinesh. 

Sashikola explained enthusiastically, “Using names within formulae makes it convenient to understand the formulas while performing any calculations. This is extremely helpful when the problem is complex. The process of finding a solution becomes easier to comprehend and maintain with the aid of names within formulae. The users can easily define a name for a function, table, constant or cell range. This practice of using names in formulae helps the users to update, manage and audit.”
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Formulae in names- how to allocate a formula directly to a range name and why that is needed
“What do you mean by using formulae in names?” questioned Dinesh again. 
“If the user knows which formulae to use, they can do that by typing wherever needed in the name. Formulae can also be chosen from the lists that are already available. In the 2007/10 versions of Excel, whenever a user starts typing a function or a formula within a name, the Excel prompts the user with the matching items. The cursor keys can also be used to enter the formulae within the names” replied Sashikola. 
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Using excel to help you make decisions
“How does Excel help in decision making?” questioned Dinesh again.  
Sashikola answered, “People make use of Excel every day for analysis of spreadsheet data. The data can be studied for making decisions pertaining to complex as well as every day situations. Excel offers several functions that can be used to accomplish the decision making task.”
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Make more profit by using excel solver to identify the best solution
“What do you mean by a Solver? How does it help a user?”, questioned Dinesh. 

“A Solver is a part of a command suite that is usually referred to as the what-if analysis tool. This tool can help in finding an optimal value for a formula in the objective cell. This is, however, subjected to limits of constraints on the formula values within a worksheet. This tool works with a group of cells which are referred to as the variable cells that help by participating in the computation of the formulas. The Solver also adjusts the values in the cells of decision variables and help in satisfying the limits that govern the constraint cells. This helps in achieving the results desired in the objective cell”, explained Sashikola. 
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Problem solving
“Excel has a great role to play when it comes to problem solving. It can help in solving real-life problems. Businesses greatly benefit with the use of Excel in problem solving.” Added Sashikola while explaining the problem solving capacity of Excel. 

“How does one turn a problem into a mathematical form and use formulas to solve them”, questioned Dinesh. 

“Well, this can be done with careful planning and understanding of the problem. There are tools that significantly help in problem solving. Logic needs to be applied in the situation without which nothing is possible to achieve.”

Boolean logic and its usefulness
“Have you come across the term Boolean logic?”, questioned Sashikola this time much to Dinesh’s surprise. 

“Yes, but I could never comprehend their usefulness”, replied Dinesh. 
“Logical operations form the core of programming. These can be used in Excel as well. You can become an advanced excel user by understanding the terms IF, AND, NOT and OR functions. Logical operators can be used within formulas for solving complex problems. Flexibility is offered in the use of logical operators. For instance, these can be used to compare cells and also the results when two or more formulas are used”
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Combining logic and arrays to solve complex problems
“What is the best way of solving complex problems? Should I use functions or Boolean logic?”, questioned Dinesh.  

“To become an advanced user, you must first understand how and when to use the array formulas. You need to understand where the non-array formulas wouldn’t work. A worksheet can be made more powerful by turning few formulas within the worksheet into array formulas. This even simplifies the entire problem solving process. An array formula can perform calculations on columns and rows of the cells”, explained Sashikola. 

Test your Understanding

7. Suppose, you need are working on a complex problem and have a strict deadline to adhere to, which feature of Excel would use to speed up the calculations and obtain accurate results? 
8. Suppose, you have numerous calculations to be performed to solve a complex problem in a traditional way, then which power feature of excel would you use to obtain an optimal solution? 
9. Suppose, you have a huge volume of data with you, which excel feature would you use to make data analysis simpler? 
10. Suppose, you have been asked to solve a problem, what kind of approach would you adopt to take any decision? Which advanced excel feature would you adopt in this process? 
11. Suppose, have to make a logical decision, which power feature would you incorporate in your problem solving process? 
Use of Excel Interactivity in Industry
· Introduction

· Form controls

· Use form controls to make others life easier

· Using a spin button to choose a value easily

· Use option button to choose value with a single click

· Choosing from the lists

· Visual basic and macros

· Creating macros by writing a visual basic code

· Writing excel functions with VB code

· Understanding volatile functions

· Triggering a macro when a particular cell is changed

· Handling errors efficiently

· Test your understanding 

Introduction

Dinesh gets excited after getting a brief knowledge on the usage of Advanced Excel in the present day economy. He wasn’t aware of these features before. His cousin introduced him to a few sites that clearly highlighted the aspects of Advanced Excel usage in the Indian industries. He was astonished to find out that Advanced Excel has a key role to play in the international market.  He discovered that in minutes, tons of calculations could be done. He makes up his mind to become an advanced excel expert like Shasikola. He expresses his wish to learn advance excel techniques from Sashikola. She was aware of the present condition of Dinesh’s family and agrees to help Dinesh throughout.  
Sashikola starts describing more about advanced excel sectors such as: 

1. How to form controls in excel and its use in the market.

2. Visual basics and macros, how to create macros by writing visual basic. Triggering macros and handling errors efficiently.

She asks Dinesh to visit her every Sunday for further sessions on Advanced Excel. She also asks him to do some homework to get clear with the concepts of Advanced Excel.   

Objectives: 

After you will finish reading this chapter, you will be able to:
· Use form controls in solving complex problems

· Use option button to choose value with a single click

· Choose from the lists

· Create macros by creating visual basic code

· Create a macro that performs one or more actions on selected cells

· Recognize volatile functions

· Handle errors efficiently

Form controls

Sashikola started Advanced Excel training session with Dinesh by posing a question, “Have you ever come across the term form controls at work?” 

“Yes! I’m not aware of the concept entirely”, replied Dinesh. 
“Form controls are specifically designed for use on macro sheets. These can be used wherever the user wants to refer and interact with the cell data without having to use any sort of VBA code. These can also be used when a user wishes to add controls to the spreadsheets. For instance, after the addition of a list box control to a worksheet and upon linking to a cell, the user can return a numeric value based on the position of the item which is under control. This value can then be used in conjunction with other functions to select various items from the list. Form controls can also be run with macros. An existing macro can be attached to a control or a new macro can be recorded for the purpose”, explained Sashikola. 




“Can form controls be placed in a worksheet?” asked Dinesh. 

“Yes! Form controls can be placed within a worksheet that enables the users the functionality to interact with the data. These controls help in data selection. For instance, list boxes, scroll bars, drop-down boxes and spinners can be used to select items from a list”, replied Sashikola.

“Where do I find form controls?” fired back Dinesh. 

“Form Controls can be found on the Developer Tab which is present within the Insert From Control option.”  
Use form controls to make others life easier
“Why should one use form controls”, questioned Dinesh. 
“Form Controls must be used to impart a visual style to the worksheet a user is working on. These are much simpler when it comes to usage as built in methods are offered to place values within the cells of worksheet easily without having to make use of programming”, replied Sashikola. 
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Using a spin button to choose a value easily
“There is a feature called Spin button that can be used by the user when a discrete amount of choices are to be made for entering the data within an Excel worksheet. This can save a considerable amount of time by just automating the entire process of data entry. This can be done in a number of ways. Using a spin button is one such option in Excel. These add an interactive element within the Excel charts”, further explained Sashikola on spin buttons in form controls. 
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Use option button to choose value with a single click
“What are option buttons?” quickly Dinesh posed a question. 
“Option buttons are inserted within a group of selectable controls that are mutually exclusive and visible to the users at a time. For instance, if a user has five options to choose from and the options have to be presented without having to scroll the list, then the user must certainly opt for option buttons. This lets the users scan through all the options quickly and select the option best suited for them. These can even be used when you wish to make a single selection. Option buttons can also be used to display all the options that are available simultaneously”, replied Sashikola. 
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Choosing from the lists
“How does one choose from the lists”, questioned Dinesh. 
“I was working with a client previous week and had to select an option from the drop down list of data validation. Even after zooming the worksheet to 75%, the client wondered how could one read the data in such a small font”, Sashikola started explaining. 
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“Unfortunately, there isn’t any way that can help in making the font size bigger and this happens to be a drawback of opting for a drop down list for data validation. Other options can be considered while selecting lists. Form and ActiveX Control Combo Box can be used for the purpose”, added Sashikola. 
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“The users can even make use of flexible lists. Form Control Combo Box offers a more control over the appearance of the lists. The number of drop down lines can be adjusted from the tool box and the combo box can be linked to a cell. More property adjustments can be done with the aid of ActiveX Control Combo Box”, added Sashikola further.
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Visual basic and macros

“I have heard about Visual basic and macros, but I’m not aware of the applications. Could you shed some light on the topic?” questioned Dinesh.  
“Visual Basic [VB] is a programming language that has been developed by Microsoft. Excel makes use of this tool to develop programs that can significantly control Excel operations”, explained Sashikola. 

“Some aspects of Excel can be automated with the use of Visual Basic and macros. For instance, the users can create a program to format the month-end sales report. After the development and testing of the program is done, the macro can be executed with just a single command. This will let Excel perform all the calculations automatically”, added Sashikola further. 
Creating macros by writing a visual basic code
“How can I create a macro”, questioned Dinesh. 

“Tasks can be automated by the creation of macros. A developer tab needs to be turned on for creating macros. The steps are quite simple”, Sashikola explained. 
[image: image69.png]icrosoft Visual Basic - PERSONALXLS - [Module1 (Code)] =] B3

Fle Edt View Insert Format Debug Run Tools AddIns Window Help S x
ME-H % RA9 ] 0 mk@j‘iﬁ"}f @ |n7,col2

Project - VBAProject X [MiGenera =] [Hetioworla

u‘*p-

facro recorded by abcl23 This is a sample macro.
Keyboard Shortcut: Ctrl+Shift+M

Workbooks.Add

Range ("B2") .Select

ActiveCell.FormulaR1Cl = "Hello World!"

Range ("B3") .Select —

End Sub =





Right click on the ribbon bar and then click on the option “Customize the Ribbon”. 
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Select the Mains tab under the Customize the Ribbon option which is present on the right side of the dialog box. Then check the Developer check box.  
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Click OK. The Developer tab is situated next to the View tab.  
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Then the Command Button needs to be placed on the worksheet. Click Insert option on the Developer tab. Click the Command Button in the ActiveX Controls group.   
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The command button needs to be dragged on the worksheet. Once this is done, the Macro needs to be assigned. The user needs to right click the Command button and click on the View Code option. This opens the Visual Basic Editor.   
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The Cursor then needs to be placed between the End Sub and Private Sub CommandButton1_Click () option. The code line needs to be added.  
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Close the Editor and then click the command button on the spreadsheet. The result would be displayed as shown below.  
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Congratulations! A macro was created by you!

Writing excel functions with VB code

“How does one write excel functions with VB code”, questioned Dinesh again. 
“Although, there are several built-in functions in Excel, many times the function just needed for the kind of calculations that you wish to perform isn’t available. In such cases, Excel users can custom create functions with the use of Visual Basic programming”, explained Sashikola For this, the user needs to be aware of the programming rules. The right use of the VB keywords needs to be done while creating any program for developing a custom function. There are many rules governing the custom functions. The user even needs to document the macros and the custom functions. Custom functions and simple macros cannot be easy to read when it comes to comprehending them. They can be made easier by entering an explanatory test in the form of comments while developing the code. After the creation of Custom Functions, these need to be made available everywhere”, replied Sashikola.    
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Understanding volatile functions
“What is a volatile function”, questioned Dinesh again. 
“A Volatile Function is one that results in recalculation of a formula within a cell where it resides each time a recalculation is performed by Excel. This happens irrespective of the changes done in the formulas and the data. Volatile functions are avoided in most of the cases. Even a defined Function can be made volatile with inclusion in the code. Few functions in Excel are volatile such as RAND (), TODAY () and NOW (). One can even find less volatile functions such as CELL (), INFO () and OFFSET (). Using volatile functions within a formula flags the cell even if the function that is volatile doesn’t get executed”, replied Sashikola. 

[image: image78.png]D

=RAND()
=D1+5
_no The volatile
=D2-10 o AND
function and
dependent

formulas




Triggering a macro when a particular cell is changed
Dinesh again posed a question, “How a macro is triggered when there is a change in a particular cell”.  
“A macro can be created in Excel only when a value is entered within a cell of a particular sheet. There are many instances where a macro can be run only when values are entered in a certain number of cells. A macro can be triggered upon changes in the particular cell. Click on the View Code after right clicking on the Sheet1 tab. The module sheet behind the Sheet1 opens upon doing this. The code that has been provided below needs to be entered into the module sheet”, replied Sashikola. 
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Test your Understanding
12. Suppose, you are working with a huge volume of data, which kind of Excel feature would you use to manage the data easily? 
13. Suppose, you have numerous options presented to you, which form tool would you use to make the selection process easier? 
14. Suppose, you have various items to be displayed in a list, which Excel list feature would you use to display the options in a convenient manner?  
15. Suppose, you have to solve a problem with a function that isn’t inbuilt in Excel, how would you create the function for solving the problem? 
16. Suppose, you have to call a function in between, how would you trigger a macro for the purpose?  
Wide Range of Use of Spreadsheet in Industry
· Introduction

· Practical interactivity with VBA

· Exchanging the information with VB code

· Displaying a message box

· Using an input box for users

· Creating an excel form with a list box containing values from a range of cells

· Sample VB projects: an automatic index to sheets, pricing selected ranges

· Avoiding macros when they are not necessary

· Conditional formatting: Beyond simple conditional formats

· Base conditions on a formula

· Choose currency symbols for a whole sheet by changing a simple cell

· Getting rules in the right order

· Graphical conditional formats

· Using invisibility for advantage
· Creating charts to inspire

· What makes a good chart?

· Simple steps to make charts clearer

· How small can be better than large

· Mixed chart types, trend lines and projections

· Advanced chart technics- break even lines and waterfall charts

· Pictures in the chart columns 

· Sparkline

· In-cell charts: shows 12 times more information in the same amount

· Careful with that axis

· Different kind of Sparkline: lines, columns and win loss

· Sparkline based on dynamic data range

· Further graphics tricks and techniques

· Take a dynamic picture with the excel camera

· Combining areas from multiple sheets on the same sheet of paper

· Formatting excel camera pictures

· Power view: using the excel 2013 data visualization add-in including plotting values on maps and “playing bubble charts”

· Working with external data

· Understanding data structures

· Microsoft query: from database to spreadsheet

· Data model

· Test your understandings 

Introduction

Dinesh continues his lesson on advanced excel and day by day works in his work place gets easier to him. So he decides to move his career forward as Advanced excel expert. He gets a job circular in his company where some excel experts are needed. So he contacts Shashikola and tells her about the work opportunity. 

But Shasikola forbade him. She told him that there are a lot more opportunities in freelancer.in to work as an advanced excel expert. Shasikola explains about the work opportunity as a freelancer. She also reminded Dinesh that there are lots more to know about Advanced excel. She works as a freelancer sometimes. So she goes to freelancer.in and shows Dinesh about the work opportunities out there. Dinesh gets surprised to see the opportunities and asked his cousin if he is able to start now. His cousin laughs and tells about VBA, Conditional formatting, etc. Dinesh knew these terms but nothing more than that. So he tells Shasikola to teach him those. Shashikola makes Dinesh clear about the use of excel in inventory managements and online shopping companies. 
Getting further lessons Dinesh starts to feel the impact of advanced excel. He creates an account on freelancer.in and tries to manage get work. But as he lacked a profile on freelancer.in, he fails to get one. So he tells her about the problem. As a professional Shasikola knows what to do to get a job online. So she tells some important notes on how to get work opportunities online. She teaches him how to create a profile, how to create milestones, how to keep an eye on the deadline, how to convince people online that he can work.
Objectives: 

After you will finish reading this chapter, you will be able to:
· Exchange the information with VB code

· Create an input box for users 
· Create an excel form with a list box containing values from a range of cells

· Choose when not to use macros

· Use the conditional formatting option wherever necessary

· Choose currency symbols for a whole sheet by changing a simple cell

· Use graphical conditional formats

· Create charts in a clear and better manner

· Use mixed charts, projections and trend lines

· Use advanced charting techniques

· Use the Power view features

· Recognize the applications of data structures 

· Use data models 

Practical interactivity with VBA

“How can one interact practically VBA”, Dinesh initiated the advanced excel session with Sashikola.
“There are various kinds of simulation tools are offered in Excel which displays vital data in a single place for quick understanding. These tools offer visually display of data which help in better analysis of data”, replied Sashikola. 

Exchanging the information with VB code

“How does one exchange information with VB code”, questioned Dinesh again. 

“A message box can be used for the purpose. This enables to inform the users of the program easily. All the user needs to do is place a command button on the worksheet and follow simple procedures to exchange information with VB code”, answered Sashikola. 

Place a command button on the worksheet and insert the following code lines: 

MsgBox “This is fun”

The result is displayed upon clicking the command button on the excel sheet.
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Using an input box for users

“Input Box function can also be used in Excel to prompt the users to enter a value. For this, the user needs to be placed a command button on the worksheet and insert certain code lines”, added Sashikola further. 
1. Declare a variable myValue which is of type Variant. 

                              Dim myValue As Variant 

2. Then add the following code line within the input box

                      myValue=InputBox (“Give me some input”)
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3. Enter the value of myValue in cell A1. 
                Range (“A1”).Value = myValue

4. The result is displayed when the user enters the value and clicks OK. 
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Creating an excel form with a list box containing values from a range of cells

“How do I create an excel form with a list box”, questioned Dinesh further. 
“A list box can be used to list one or more items of text from which a choice can be made. A form control can be used for the addition of a list box”, answered Sashikola.

1. Click on the File tab after displaying the Developer tab

2. Click options and then select the Customize Ribbon category

3. Select the Developer check box and then click Ok on the Mains tab
4. Click Insert on the Developer tab in the Controls group under the Form Controls. Click on the List box
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5. Click on the location on the worksheet where you want the list box to appear.
6. In the Controls group on the Developer tab, click on Properties. Specify the properties.

7. Choose the selection kind.    

Avoiding macros when they are not necessary

“There are many users who freak out when they open their Excel workbook and come across a security warning regarding enabling macros”, explained Sashikola. 
“Why is that so”, questioned Dinesh. 

“Whenever a macro is designed to delete information and if it runs at the wrong time, it ends up deleted the work that you have spent hours working on. Hence, it is best to avoid them when not needed”, answered Sashikola. 

Conditional formatting: Beyond simple conditional formats

“Are you aware of the term conditional formatting”, questioned Sashikola. 

“No”, replied Dinesh. 
“Formatting such as alignment, color and currency enables one to display the value. However, conditional formatting offers more flexibility. Specific formatting conditions can be met with conditional formatting. Creative ways can be employed to format the data. The options are present in the format menu”, explained Sashikola. 

Choose currency symbols for a whole sheet by changing a simple cell

“What is the use of currency symbols”, questioned Dinesh again. 
“If you wish to display numbers as monetary values, then formatting of these numbers need to be done as currency. For this, the user needs to apply the Accounting number or the Currency format to the cells which needs to be formatted. The formatting options are present on the Home tab of the number group”, replied Sashikola. 



“A number can be displayed with the currency symbol by making a selection of the entire range of cells and then choosing the Accounting Number Format [image: image84.png]


”, added Sashikola further.  
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Graphical conditional formats

“What is meant by Graphical conditional formats”, questioned Dinesh. 

“Conditional formatting is used to format the content of the cell or the cell range within a workbook. These are quite simple and quick to apply. The data can be represented in a graphical manner or can even be automated. For instance, conditional format can be applied to a list of sales. This needs to be done based on the analysis of lowest and highest values of the list. The graphical conditional formatting options can be accessed  from the Styles group which is present in the Home ribbon tab. Three graphical forms of conditional formatting options are available which include Color Scales, Icon Sets and Data Bars. ”, replied Sashikola.
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Creating charts to inspire

“How can charts be used in Excel”, questioned Dinesh. 

“Whatever the task is, data representation plays a crucial role. The data can be represented in a manner to boost marketing. Regardless of the usage, a poor display of data will only suggest a badly managed data. The user needs to ensure that the data is displayed in a pretty convincing manner. Customizing graphs in excel can help significantly in managing the data appropriately and in better representation to the clients. This gives an impression that the user is aware of the work and has done it in a systematic manner”, replied Sashikola. 
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What makes a good chart? 

“What makes a good chart”, questioned Dinesh again. 
“A chart is nothing but a graphical representation of the data that you have. The data can be analyzed easily when it is represented in the form of a chart. A good chart would be one which would enable the user can identify the content clearly. The user must be able to distinguish the data provided. There are a lot of options to tweak the data using the formatting options” replied Sashikola. 

Simple steps to make charts clearer

“You need to make sure that your chart is clear. For this you need to follow few simple steps”, added Sashikola further explaining about the use of charts.  
· Pick the right graph 

Before jumping to tweaking, the user needs to be aware of the data being dealt with.        The data needs to be studied to be displayed in an optimal format. Bar, line and pie charts can be used as per the requirement. Pie and bar charts can be used to compare the data. Bar charts are easier to study and they highlight even the slightest increments. Pie charts are used when one category being compared is larger than the other category.     
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Line charts on the other hand appear to be horizontal versions of bar charts which help in displaying any changing trends over time. Multiple values can be tracked over time.  
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· Shorten the labels of Y-axis

Long Y axis labels consume a lot of space and appear messy. This can be witnessed in the chart provided below. 
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Remove background lines

Graphs offer a rough comparison of data present within a set. Nobody looks into a graph for incremental differences. The general overarching trends are noted in graphs used for comparison. To let people focus on the changing trends the users need to remove the background lines from the chart.   
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Mixed chart types, trend lines and projections

“What are trend lines, projections and chart types”, questioned Dinesh again. 

“A trend line is associated with  a series of data. It doesn’t actually represent the data, but depicts the trend of an existing data. Display of trends helps in analyzing the problems with prediction ”, replied Sashikola. 
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“It is vital to choose the right trend line as per the kind of data. The users can choose from six kinds of trendlines offered to them which include logarithmic trendlines, linear trendlines, power trendlines, moving average trendlines or exponential trendlines”, added Sashikola further.    
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Advanced chart technics- break even lines and waterfall charts

“What are waterfall charts”, questioned Dinesh. 
“Waterfall charts are used commonly in businesses to show intermediate changes in the values. For instance, businesses can project their next year’s cash flow by showing the variations in the effects of revenues and changing costs. These charts are even referred to as the bridge charts that connect the endpoints. These can be created in many ways. A stacked column chart can be created first with up and down the columns that display the trends”, replied Sashikola. 
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Pictures in the chart columns 

“Can pictures be inserted in chart columns”, questioned Dinesh. 
“A chart can be enhanced by inserting pictures such as company logo within the chart area. A picture can be used to fill and draw the attention to specific elements of the chart such as plot area, chart area and data markers. The picture can be copied to a chart ”, replied Sashikola. 
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Sparkline

“What is a sparkline”, questioned Dinesh.

 “A sparkline is a tiny chart within a worksheet cell that offers a visual representation of the data. These can be used to demonstrate trends in a series of values such as seasonal decreases or increases, highlight minimum and maximum values in economic cycles. These are not objects. These are actually tiny charts which are present in the background of a cell” replied Sashikola.    
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Different kind of Sparkline: lines, columns and win loss

“There are various kinds of sparklines: Columns, win loss and lines”, added Sashikola further explaining about sparklines. 
Lines – These are displayed in the form of simple lines. The user can easily change the sparkline color, style of line and the marker color. 



Column- These sparklines are displayed in a bar format. If the data is positive, then the column lies on upper axis and if the data is negative, the column is present below the axis. For a zero value, the space is left empty.

Win/Loss- These sparklines are displayed in bar formats. These are used to represent a profit or loss. If the data displays only profit, then the bars are present above the axis. If the data represents loss, then the bars are inverted.    

Further graphics tricks and techniques

“There are various other graphics tricks and techniques which can be used by an excel user. Would you like to know more about them”, questioned Sashikola. 
“Yes”, replied Dinesh swiftly.

 Take a dynamic picture with the excel camera

“There is a camera tool that lets you create a visual reference within an excel sheet. It is one of the hidden and the useful feature of excel. The user needs to specify any rectangular area within the workbook and a mirror image of that selected area is created by the camera tool. It can be moved and resized. The camera tool can also be used to create a micro chart in excel” added Sashikola. 

1. Create a normal chart

2. Select the cells which are surrounding the chart 

3. Click the camera tool

4. Click on the worksheet and this places a snapshot of the range that has been selected by the user

5. Resize until the micro chart effect is obtained 

Working with external data

“How does one work with external data”, questioned Dinesh. 
“It is quite simple. This can be done by having a basic understanding of data structures”,  replied Sashikola. 
Understanding data structures

“Spreadsheet is a kind of functional language which offers dynamic typing features. Each value or function can be referenced within the cell matrix. This imparts functionality to the spreadsheet, Data structures are very basic when it comes to programming. It shouldn’t be difficult to understand the concepts of data structures. These help while working with external data.”, added Sashikola further. 

Microsoft query: from database to spreadsheet

“What is Microsoft Query used for”, questioned Dinesh again.
“Microsoft Query can be used to retrieve data from various external sources. With the use of Microsoft Query, data can be retrieved from the corporate files and databases. Data needs to be retyped if analysis needs to be done in Excel. Reports can be refreshed and summarized automatically from the original source. A connection can be established with external data sources. The data can be selected from external sources. Data can be imported into the worksheet and refreshed whenever needed to keep the data within the worksheet synchronized”, replied Sashikola. 

Sashikola further added, “Data can be retrieved from a database by the creation of a query which is nothing but the data stored within an external database. For instance, if data have been stored in an Access database and wish to know the sales figures pertaining to a specific product for a specific region. A part of data can be retrieved by the section of data for the specific region, and product that needs to be analyzed.”

Data Model

“What is a data model”, questioned Dinesh. 
“A Data Model is a relatively new approach which is used for data integration from various tables. This effectively builds a relational data source within an Excel workbook. Data models are used transparently in Excel and provide data for use in Pivot Charts, Power View reports and Pivot Tables. This model allows for the creation of a model from where data can be obtained from various sources”, replied Sashikola. 
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Test your Understanding

17. Suppose, you are working with a huge volume of data, which tool would you use to represent the data clearly? 
18. Suppose, you have a huge volume of data and you wish to draw comparisons between two sets, then which graphical conditional formatting tool would you use? 
19. Suppose, you have to insert your company logo which representing data using graphical tools, which feature of excel would you use for the purpose? 
20. Suppose, you have data which represent profit and loss, which tool would you use to represent such data? 
21. Suppose, you have data where integration needs to be done from various tables, which feature would you use for the purpose?  

Why most companies need to turn data into decisions? 
· Introduction

· Using advanced pivot table to do more with your data

· Calculated fields and calculated items

· Using pivot tables as the calculation engine

· Using GETPIVOTDATA () and CUBE formulae to create flexible reports

· Make pivot table more interactive 

· Working with the pivot charts

· Building and interactive dashboard using pivot table and Slicers

· Excel 2010 & 2013 Power pivot add-in

· Power Pivot data tools

· Calculations in power pivot

· DAX in table columns

· DAX to create new measures and calculated fields

· Understanding advanced DAX expressions

· The Time Intelligence DAX functions

· Creating reports with power pivot

· Hierarchies, perspectives and sets

· Adding key performance indicators(KPIs) to a power pivot report

· Creating CUBE formulae to report in your own way

· Using all these techniques to turn on millions rows of data into a dashboard that supports better decisions.

· Test your understanding
Introduction

So, Dinesh is working now as a freelancer, along with his present studies. After working for a few days he gets a work which included working with a pivot table. He was fully unaware about this thing. He tried in many different ways to solve the problem, but still he remains stuck with this one.
So having no other way, he contacts Shashikola. Shashikola is not that much expert in pivot tables and power pivots. She knows about courses being conducted on Advanced Excel. So she gathers some information about the courses and informs her cousin to do a course on Advanced Excel. 

Dinesh gains admission into the course and upon completion of the course he gains a clear idea about the topic.  He gets a brief knowledge about pivot table, how to use pivot table as calculation engine, DAX expressions, etc. The course also included the importance of Excel in modern day economics. Dinesh became clear that there are a lot of fields out there to work as an excel expert.
Objectives: 

After you will finish reading this chapter, you will be able to:
· Calculate fields and calculated items with pivot tables

· Use pivot tables as the calculation engine

· Create interactive pivot tables

· Create interactive dashboards with pivot tables

· Perform calculations in power pivot

· Understand advanced DAX expressions

· Create reports with power pivot

· Create CUBE formulae for reporting

· Use techniques to convert millions rows of data into a dashboard that supports better decisions 

Using an advanced pivot table to do more with your data
“How can I use advanced pivot table for data handling”, questioned Dinesh after attending a course on Excel. 

“Pivot tables are really powerful and useful feature offered by MS Excel. These can be used to analyze, summarize, present and explore the data. Pivot reporting and tables enable a user to analyze huge volumes of data and procure solutions in a matter of few clicks. Advanced users are aware of the features of the Pivot tables and make use of them efficiently. Slicers, calculations and grouping are few popular features of pivot tables which can be used to handle data much efficiently”, replied Sashikola. 

Calculated fields and calculated items
“What is the use of calculated fields and calculated items”, questioned Dinesh curiously.

“After a user creates a pivot table, they can enhance the structure by creating their own formulas with the aid of calculated items and calculated fields. Calculated fields are used to perform calculations in the pivot table on other fields”, explained Sashikola.
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She further added, “A calculated column lets you make additions in an already existing Power Pivot table. The user can create a DAX formula which can define the values of a column instead of importing or pasting values. The formulas are much easier to create. The formula is applied to the entire column. Whenever a column consists of a formula, the computation is done for each row. The results are calculated as soon as the formula is created. A calculated field on the other hand is a formula that has been created specifically for use in a Pivot chart or table that utilizes the Power Pivot data. The calculated fields are based on the functions of standard aggregation”.   

Using pivot tables as the calculation engine
“Do you intend to say that pivot tables can be used as a calculation engine”, asked Dinesh.
“Pivot tables let the users enjoy quick analysis and calculations. Millions of rows can be processed in the same time that is required for processing thousands of rows with the use of pivot tables. Multi core processors and huge memory can aid in processing the calculations in no time. These tables overcome all the limitations that exist pertaining to analysis of massive data. Efficient compression algorithms help in loading a huge volume of data easily and hence it wouldn’t be wrong to compare pivot tables to a calculation engine”, answered Sashikola firmly.  
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Using GETPIVOTDATA () and CUBE formulae to create flexible reports
Dinesh again posed a question, “How can one create flexible reports in Excel”? 
“Several layouts are present within a Pivot Table report, which possess a predefined structure. These cannot be customized. For more flexibility in the layout design, the users can convert the cells into formulas and then incorporate changes in the layout. GETPIVOTDATA or Cube functions can be used for the purpose. Conversion of cells into formulas simplifies the entire process of creating, updating and maintenance of the Pivot Tables that are customized”, replied Sashikola. 
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Sashikola further added, “The significant weakness associated with Pivot Tables is the inability to format them. This can be overcome by using functions. The Pivot Tables are based on OnLine Analytical Processing [OLAP] cubes. These tools are present in the Pivot Table Tools, Analyze tab.”
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Make pivot table more interactive 
“How can I make Pivot tables more interactive”, questioned Dinesh excitedly. 

“Excel offers powerful tools to the users when they are dealing with a large amount of data. The data can be analyzed in multiple tables and the users can create visual, interactive reports with the aid of these tools. The users can follow several steps to make Pivot tables more interactive”, replied Sashikola amused by the enthusiasm with which the question was posed.
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· Use Excel recommended Pivot Table

             This will let you quickly analyze the data. Pick the layout of the table recommended 

             by Excel for the purpose.

· Conduct data analysis in multiple tables

Excel offers Data Model functionality. The user just needs to add data in multiple tables and then establish a relationship between the tables created. A Power View sheet can be used for the purpose.  

· Plot the data into the interactive Pivot Chart directly

Excel lets the users create a decoupled chart which lets the users interact with the data and filter it accurately.  
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· Utilize Power View and Power Pivot to the fullest

Dinesh again raised a question, “How can one utilize Power View and Power Pivot to the fullest”. 

Sashikola promptly replied, “Advanced Excel users need to take full advantage of these powerful add-ins offered by Excel. The data analysis can be done with a built-in model when multiple tables have been created. A sophisticated model can be created with the use of Power Pivot. The Power View feature helps the users to turn the data into an interactive professional report which can be analyzed easily.”
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Working with the pivot charts
“What is the significance of Pivot Chart report”, questioned Dinesh. 

“A graphical representation of data is offered by a Pivot Chart report. These reports are interactive. Whenever a user creates a Pivot Chart report, the Filter Pane appears which the user can use to sort and filter the data present within the report. Changes made to the layout and also to the data and reflected immediately within the report. These reports display categories, data series, axes and data markers. The users can also change the chart type and also the options that come along such as the legend placements, titles, chart location and data labels”, answered Sashikola.
Building and interactive dashboard using pivot table and Slicers
Sashikola questioned Dinesh much to his surprise, “Now, that you have done a course on Excel, could you explain about interactive dashboard with the use of Slicers and Pivot table.”

Dinesh replied, “Slicers were introduced in Excel 2010 which lets the users to filter the PivotChart objects and Pivot Table. A Slicer instead of a drop down menu displays a set of buttons which can be used to filter the data easily. These make an ideal addition to the dashboard where the user wishes to filter the data easily. These are simply visual filters. The users can easily filter their data by clicking on the kind of data desired.” 
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For instance, if you’re using a pivot chart to look into the sales and want to analyze the sales within a particular region then you can make use of two options. 

· You can add a report filter of the region and then filter, whichever region you wish to analyze the sales. 

· You can add a slicer on the region and then click whichever region you wish to study the sales.
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Slicers can be used to create interactive charts in Excel. Here are the steps: 

1. Create a pivot table that provides the data for the chart

2. Slicer can then be added for interaction on the field

3. Create a pivot chart from the table data that you have

4. Move the slicer adjacent to the chart and format everything as per your taste

Excel 2010 & 2013 Power pivot add-in
Sashikola again questioned, “Have you learnt anything about Excel 2010 & 2013 Power pivot add-in.”

Dinesh replied, “Powerful data analysis can be performed with Power Pivot add-in in Microsoft Excel. By default, this feature hasn’t been enabled. However, it is inbuilt in Excel.” 

The user needs to just follow few simple steps to make use of the add-ins: 

1. Go to the File menu and then click on Options to access the Add-Ins feature

2. From the Manage box, choose COM Add-ins and then click on Go. 

3. Check the Microsoft Office Power Pivot option in Microsoft Excel 2013 box and then select OK.   
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Power Pivot data tools
“Can you tell me something about Power Pivot data tools”, asked Sashikola. 
“Yes! The industry requires Advanced Excel professionals to crunch and squeeze large sets of data. Meaningful decision pertaining to data needs to be taken quickly. This ability comes in the form of add-ins that are quite powerful. Power Pivot feature is the most sought feature which helps in analyzing multiple sets of data within the same table. Power Pivot add-in enables a user to import millions of data rows from various sources within a single workbook. A relationship can then be created with the heterogeneous data. These help the users in analyzing the data collected in the form of pivot charts, calculations and tables. Power Pivot connects the tables from the database but it doesn’t connect the sources of data”, replied Dinesh.”
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Calculations in Power Pivot
Sashikola again questioned, “Can you shed some light on calculations in Power Pivot.”

Dinesh replied, “Calculations in Power Pivot can be used for data analysis and in solving modeling problems. Two kinds of calculations can be done in the Power Pivot: calculated fields and calculated columns. These calculations make use of formulas. For instance, while creating a calculated field with the aid of AutoSum feature through the standard aggregation function such as AVERAGE or SUM, then the users do not have to create any formula. This is automatically created by Power Pivot. In certain cases, the users have to create a custom formula which can be done with the aid of Data Analysis Expressions [DAX].  DAX formulas are quite similar to Excel formulas. These make use of the same operators, syntax and functions as the Excel formulas. These, however, come with additional functions that have been designed to perform dynamic calculations.”    
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DAX in table columns
Dinesh further explained, “The Data Analysis Expressions [DAX] is a kind of language that lets the users to define custom calculations in measures and calculated columns. These include a few functions that are used in Excel formulas. DAX includes a few functions which are used in Excel formulas. There are additional functions which have been designed to perform dynamic aggregation and relational data. DAX formulas are quite similar to the formulas used in Excel. To create a formula, the users need to type an equal sign followed by the expression or name. Required arguments and values can also be typed. DAX offers a variety of functions which lets the users to perform calculations and work with strings.” 
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DAX to create new measures and calculated fields
“How can one create new measures and calculated fields using DAX”, questioned Sashikola. 

Dinesh answered, “DAX formulas can be used in the calculated columns with the addition of columns and then by typing the expressions within the formula bar. These formulas can be created with the aid of Power Pivot window. These formulas can be used in measures. These formulas can be created with Excel. Add Measure feature needs to be clicked within an existing Pivot Chart or Pivot table. Calculated formula needs to be applied to each row within the column to the entire table. The value may change depending on the context of the row. The results of the calculations are strongly dependent on the context, in a measure. The choice of row and the design of the Pivot Table significantly affect the values that are utilized in the calculations.”    

Understanding advanced DAX expressions
Dinesh also explained, “There are several advanced DAX expressions which the users can make use of. The users can make use of the nested functions which enables the users to get the result from one function and use it in another function as an argument. The users can nest 64 function levels within the calculated columns. Nesting makes it quite difficult to troubleshoot formulas. Power Pivot functions are designed to be used as nested functions. These return the results in the form of a table which cannot be saved in the in the form of a workbook. These need to be provided in the form of an input table function.”  
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The Time Intelligence DAX functions
“Have you heard about Time Intelligence DAX functions”, questioned Dinesh. 
“No”, replied Sashikola. 
Dinesh explained, “Data Analysis Expressions also consist of the time intelligence functions which are used to support the requirements of the Business Intelligence analysis. This enables the users to manipulate the data with the use of time periods which includes months, days, years and quarters. The calculations can be built and then compared over the time frame with the aid of Time Intelligence DAX functions.”  

Creating reports with power pivot
Sashikola added, “I have heard about the creation of reports with Power Pivot. Reports can be created based on the information available in the Power Pivot workbook which has been published to SharePoint. These reports offer a great visualization of data through maps and charts. These can be saved in the form of Word of PDF. Reports can be used to render, visualize and distribute the data and it also offers alternatives that are quite powerful when it comes to managing business intelligence data.”   
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Hierarchies, perspectives and sets
Dinesh continued the conversation and asked, “Do you know anything about Hierarchies, perspectives and sets.”

Sashikola replied, “Hierarchy refers to a viewable list, which is a collection of columns and lets the users create levels and place in order. These appear separate from various other columns that are present within a reporting tool, thus making it easier for the clients to make selections and navigate through the data.  The Tables can include hundreds of columns with complex data when it comes to data used in industries. This makes data inclusions within the reports quite complicated. The client can make use of the hierarchy option and report everything in just one click. Hierarchies also offer an intuitive and simple view of the structure of the data.” 

Sashikola also added, “Hierarchies can be included within perspectives which can be used to define viewable subsets. These models offer focused and viewpoints that are specific to businesses. For instance, a perspective can provide the users a hierarchy of the data items that are vital for reporting specific items. The users can easily create, delete or edit hierarchies with the aid of the Diagram View feature.”    
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Adding key performance indicators (KPIs) to a power pivot report
Sashikola questioned, “Do you know anything about Adding key performance indicators (KPIs) to a power pivot report.”

Dinesh replied, “Key performance indicators are used to measure the performance visually. These are designed to help the users evaluate values quickly and measure the status of metric against a target based on specific calculated field. The performance of a value is gauged by KPI. This value is defined by a base field that is calculated against a target value.”   
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Creating CUBE formulae to report in your own way
“Do you know anything about CUBE formulae”, questioned Sashikola. 

Dinesh replied, “CUBE formulas let the users to add SSAS tabular calculations or Power Pivot calculations within any cell in any orientation which the user wishes to have. These offer immense flexibility. CUBE formulas are basically worksheet functions.  Using all these techniques to turn on millions rows of data into a dashboard that supports better decisions.”

Dinesh further added, “Power Pivot offers immense benefits to the organizations which make use of spreadsheet database. Power Pivot makes it possible for the workbooks to store millions of data rows within a workbook and process the data at a tremendous speed. SharePoint feature can be used to manage the issues pertaining to saving the values returned from the table. A workbook can be setup with the Power Pivot dataset. These workbooks can be used to set up one or more Pivot tables in the form of a spreadsheet database. Set up the workbook which returns the data from the database in the Power Pivot workbook created. Numerous workbook reports can be created by following this procedure.”      
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Test your Understanding

22. Suppose, you are working with data sets that are huge, which Excel feature would you use to make the data representation interactive? 
23. Suppose, you need to perform millions of calculations with a data set, how would you accomplish the task?  
24. Suppose, you have to perform quick calculations with a data set, which functions would you use to perform this work quickly? 
25. Suppose, you are making use of the Power Pivot feature in Excel, which expression do you use to perform the calculations? 
26. Suppose, an Excel user in a company has to periodically deal with data and study it, which feature needs to be used to accomplish the task easily? 
Future Possibilities for Advanced Excel Professional
· Introduction

· Google Spreadsheet and its usefulness  

· Related Fields

· Further Studies

· Other Options

· Current trends in Advanced Excel

· Test Your Understanding

Introduction

Working as an excel expert was Dinesh’s dream and now it has manifested into reality. He thanks his cousin Shashikola from his heart. Without her help, he wouldn’t have realized his dream. 

Sashikola is extremely happy that she could provide the required help. She explains Dinesh about the future possibilities of being an Advanced Excel Professional. Dinesh questions her about the related fields, further studies and other options pertaining to advanced excel.  Shasikola made the following topics clear:

1. What are the related fields to Advanced Excel

2. Further studies on this sector

3. Other options while working with Advanced Excel

Dinesh was aware of Google spreadsheet, but wanted to be clear and hence questions his cousin. Sashikola discusses all the aspects of Google Spreadsheet and the difference considering various aspects. 

Objectives: 

After you will finish reading this chapter, you will be able to:
· Use Google Spreadsheet

· Understand the usefulness of Google Spreadsheet

· Learn about related fields 

· Understand various options

· Learn the current trends in Advanced Excel

Google Spreadsheet and its usefulness

Dinesh after gaining a broad perspective on the Advanced Excel questioned Sashikola, “How is a Google Spreadsheet useful in comparison to Advanced Excel.”
Sashikola replied, “Microsoft Excel is a widely used spreadsheet program. It is one of the simplest applications that can be used to deal with a huge volume of data and is an extremely powerful tool. It also makes use of in complicated applications owing to its flexibility. It is used for analyzing scientific data and also for  producing financial models for businesses. India has witnessed a tremendous increase in Microsoft Excel users.”

“Excel offers assistance in calculating and auditing data. It finds wide applications in logical, financial, statistical, math, engineering and data reporting applications. We live in a world where there are several software alternatives. Google spreadsheet is one such alternative”, added Sashikola further. 
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Dinesh questioned, “Could you explain more about Google Spreadsheets”.

Sashikola immediately answered, “Google offers its own spreadsheet software within its Docs web application which offers advanced and standard formulas, formatting and importing of Excel documents and offers a decent set of graphical tools.”
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She further added, “Google Docs applications let multiple users to update and edit a single document. Sharing of the documents is also easy thus letting users generate URLs and share the settings in a dynamic manner. This application is a straight replacement for Excel.”  
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“What are the features offered by Google Spreadsheet”, questioned Dinesh almost instantly. 
“Google Sheets, Slides and Docs are the productivity apps that let the users create various kinds of documents and work on them with a bunch of people real time. These documents can be saved online for free and can be accessed from anywhere in the world. Google Spreadsheets let the users create and format spreadsheets while working with people simultaneously”, replied Sashikola. 

Google Sheets allow the users to :

1. Import excel documents and convert them to other formats

2. Export excel documents

3. Use formula to edit the data and even perform calculations

4. Chat with other users who are working on a single spreadsheet

5. Create interactive charts with the data available

6. Embed spreadsheets on websites or blogs

7. Offline creation and editing options

8. Improved function editing tools
Sashikola further explained, “Google Sheets let the users to make their data standout and interactive with the use of colorful graphs and charts. Pivot tables, conditional formatting options and built-in formulas simplify the spreadsheet tasks and also save time. Whether a user is trying to create a spreadsheet for analyzing the data or to keep track of the personal finances, Google Sheets can be used for the purpose.”
Dinesh questioned, “Which one would you prefer working with: Google Sheets or Excel.”

Sashikola replied, “It’s all about personal preference. Excel’s desktop version has been in use for many years. Google Sheets are just unbeatable when it comes to price. The entire suite of Apps is offered for free. The business level subscription doesn’t cost much.”
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Sashikola further explained, “Google Apps offer several advantages owing to its ability to quickly collaborate with other users. Excel lets the users to make use of Track Changes feature which allows simultaneous editing of spreadsheets. Excel also lets the users save the spreadsheets in Dropbox or Skydrive. However, Google Sheets are unbeatable when it comes to cloud storage. Google Sheets get saved automatically in the cloud that is attached to the user’s Google account. These files can be accessed with a web browser from any computer. Issues pertaining to the use of the same version of software are eliminated in the case of Google Sheet.” 

Dinesh added, “Google offers fantastic web integration services.”
Sashikola again started explaining, “Google Sheets must be used if the users want to make use of Google power.”  
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“Why is Excel considered to an industry standard when Google Sheets offer several advantages”, questioned Dinesh. 

Sashikola replied, “There is a reason why Excel has earned the fame of being the industry standard. Excel shines when it comes to data processing. It’s hard working with Google Sheets after dealing with 1,000 rows of data. The app tends to get slow after that. Loading the spreadsheets consumes a lot of time if the data is huge. Excel can work with hundreds of thousands of rows without getting sluggish. ”
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She further added, “Excel lets the user do a lot of amazing things with the formulas from managing everyday activities to doing with the taxes. Google Sheets is relatively new and trying to catch up with Excel features. Data processing is easier with the aid of Excel functions.”  
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Sashikola even added, “Excel’s ubiquity is an added advantage to the users. Importing spreadsheets with the use of Google Sheets result in tremendous formatting errors which consume a lot of time while fixing. As Microsoft Office has been in use for years, the users find the familiarity hard to ditch.”
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Dinesh quickly added, “So, both have their own advantages. Sheets don’t come with a price tag and have capabilities for being used online and also make collaboration with other users easy. These can be used by anybody who doesn’t have to do major data processing tasks. Excel significantly appeals to people who are in need of a powerful spreadsheet app. People in industries working with thousands of cells of data and those who require top notch functions in order to perform complicated calculations prefer Excel. Professional world all over the world is still ruled by Excel.” 
Sashikola added, “Ultimately, it boils down to the priorities of the users.”
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Related Fields 

Dinesh again posed a question, “Are you aware of Excel related fields that are trending in the industry.”
Sashikola replied, “When it comes to computing, Microsoft Excel is the most commonly used applications. There are many related fields to this spreadsheet program which users can utilize.”

1. Google Docs Spreadsheet
Many users have Google accounts which entitle them to access Google Docs Spreadsheet. This is Google’s own version of the spreadsheet application which bears resemblances to MS Excel. The difference lies in the fact that this is offered free of cost and doesn’t have to be downloaded to the desktop.

Google Docs Spreadsheet is quite similar to Excel. It offers the same functionality as Excel which includes creation of formulas and range of charts. These can also be used from anywhere, as long as the user has access to the internet. This makes working with spreadsheets quite easier with online backup of the work done. These can even be accessed from remote areas.     
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2. Open Office

More and more businesses are utilizing this solution these days. This tool is feature rich and is a downloadable program. This tool can be operated locally on the devices such as laptops and personal computers and works on Linux, Mac OSX and Windows. This is pretty much similar to Excel and offers macros, charts and familiar features to Excel users. Upon downloading this tool, there is no need to access the internet to make this program work. Users can open, create and edit worksheets without any hassles.   
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3. Excel Web Application 

This is a web version of Excel application. This is available for free of charge and one just need to have a Microsoft account to utilize it. The web application doesn’t offer all the features of Excel. For instance, the users can’t edit VBA codes and spark lines with this. Internet access is required to make use of this application.     

Sashikola further explained, “There weren’t many related fields to excel a few years ago. These days there are many applications that offer functionality similar to that of Excel but not entirely. Excel offers in depth functions and has really established itself well with its reliable services in the industry. It finds applications almost everywhere. Though there are decent alternatives, Excel cannot be replaced owing to the flexible options offered by it to businesses.”

.
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Further Studies
“What are various other options for further studies offered to Advanced Excel experts”, questioned Dinesh. 
“For an expert level understanding of Advanced Excel, the users can learn about complex data analysis, detailed manipulation tasks which can offer more functionality to Excel users. The use of nested functions, database tools and filtering functions can greatly help when it comes to mastering Advanced Excel”, replied Sashikola. 
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Sashikola further added, “Excel’s advanced functions help the users to export and import of the huge volume of data, date and time functions, mathematical and statistical functions. Various functions such as Text functions, Information functions, Math functions, Statistical functions and financial functions hold prominence in the industries where the experts need to quickly process huge volumes of data.”
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“What about Recorder Workshops”, questioned Dinesh? 

“Recorder Workshops are conducted to teach more advanced techniques to the Excel users who work with macros often. For instance, these workshops teach how to test macros and how to create buttons that would trigger macros. The topics covered in these workshops include data preparation for an application, recording of a summation macro, recording consolidations, recording divisional macros, testing macros and assigning macros to objects.  

”
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Current Trends in Advanced Excel 

Dinesh questioned, “Could you explain the current trends in Advanced Excel.”

Sashikola promptly replied, “Nowadays, any analyst or managerial role requires one to work with a huge amount of data. Excel remains one of the easiest to use and powerful tools when it comes to data crunching. Microsoft Excel has grown to be one of the most important programs that are used in workplaces all around the world. Industries in India have adopted this software for data processing. It finds immense applications in organizing client sales lists, planning office gatherings and budgeting.”
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· Advanced Excel Trends 
1. Accounting and Finance
If you manage to walk through any accounting or finance department of any corporate office from Wipro to Infosys, you would be able to see computer screens filled with spreadsheets outlining budgets, forecasts, financial results and plans which play a key role in making business decisions. This business area benefits greatly from Excel Spreadsheets. Advanced formulas can be made use of to process a huge volume of data in minutes. 
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2. Product Management and Marketing

Product and Marketing professionals expect their finance teams to conduct heavy financial analysis with the aid of spreadsheets to list sales targets and customers. The sales force can easily be managed and the professional can plan future marketing plans by studying previous results. Quick summary of sales and customer data can be done using a pivot table. Excel knowledge greatly benefits all parts of businesses including marketing functions. 
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3. Human Resources Planning

Many softwares like SAP, Quickbooks and Oracle are used to manage employee information and payroll. Exporting data with the aid of Excel helps the organizations to discover the latest trends and summarize the expenses easily by month, hour or pay period. This provides a better understanding of the workforce functions and even about the pay level. Human Resource professionals make use of Excel to get and understand the employee data and to control costs.     
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Dinesh added, “Excel can be used for any purpose. There are no limits for Excel applications. Excel helps in creation of revenue growth models for products based on customer forecasts. Expense categories can be listed while creating budgets for small products. These can be updated frequently to understand how close the project is to the budget allotment. Customer revenue can be summarized by products and areas for building strong customer relationships can be identified.”
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Sashikola further added, “Excel is here to stay. Businesses will rely on this powerful tool for applications and diverse functions which are predominantly used by IT giants such as Wipro, and Infosys. It is vital for office professionals to have a working knowledge of Excel. Strong Excel skills open up the door for leadership opportunities and promotion. Quantitative analysis, statistical analysis of huge volumes of data can be done easily with the aid of Excel tools. Excel finds applications greatly in the business world. Areas such as business development, finance, marketing and sales find Excel extremely useful. This tool is robust and helps in easy documentation. Walk into any industry whether it is IT or core manufacturing sector, you would find Excel experts everywhere crunching numbers.”
Test your Understanding
27. Suppose, you have a data set which you need to process while you are traveling, which tool would you use for easy data backup?  
28. Suppose, you have the option of using Google Sheets and Microsoft Excel, which tool would you work with when you have a huge volume of data to deal with?  
29. Suppose, you have to deal with complex functions which processing data, which tool would you make use of for the purpose? 
30. Suppose, an organization has a huge set of employee information, which feature of Advanced Excel should be used for processing the information and for predicting the trends? 

31. Suppose, you have to develop revenue growth models for an industry, which Excel feature would you use to accomplish the task?   
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